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When someone leaves a voicemail for you, IC sends an 
email message to you with the voicemail .wav file 
attached to it. This message appears in your email client 
(e.g., Microsoft Outlook, Microsoft Outlook Express, 
Lotus Notes, etc.) with an attached .wav file. The 
Microsoft Outlook form is shown here:

By default, voicemail messages begin to play automatically 
through your computer’s speakers. If you want the voicemail 
messages to play only when you click on the Play button, in 
the Interaction Voicemail form, from the Tools menu, select 
Options and clear the Play voicemail automatically on 
open checkbox.

Using the Interaction Voicemail Player

Configure the Interaction Voicemail Player

The Interaction Voicemail Player not only plays voicemail 
messages but also allows you to control the playback of the 
message and your message indicator light. You can also 
configure Interaction Voicemail Player to play voicemail 
messages back to devices such as PC speakers, a station 
phone on your desk or to a remote telephone number. 

You can play, replay, rewind, fast forward, save, and change 
the volume of the message by opening your voicemail 
message in your email Inbox. You can forward the message 
to another person, just as you would any other email 
message. In addition, you can configure the alerts you 
receive for new voicemail messages. You can also listen to 
and manage your voicemail messages by using the voicemail 
features on your telephone. See the Interaction Voicemail 
Player online help for details on these settings.

To configure voicemail playback, open the Tools menu, 
choose Options, and then determine your startup options 
for the voicemail player. You choose the playback device 
from the Play To: dropdown list when you open Interaction 
Voicemail Player.

To play the attached file, double-click or download it and 
then open it. The voicemail message plays in either the 
Interaction Voicemail Player or your selected media 
player, depending on your configuration settings in the 
Voicemail Player Options dialog box. If you are using the 
Interaction Message Store, just double-click on the 
voicemail .wav and the Interaction Voicemail Player, 
shown in the following image, plays the message. 
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Receiving and sending faxes in the Interaction Fax Viewer is 
as easy as opening an email message or printing a document. 
When you receive a fax, it appears as an attachment to an 
email message in your Inbox. The Unified Messaging Client 
must be installed on your workstation before you can use 
Interaction Fax Viewer. Contact your IC administrator if you 
do not have the Unified Messaging Client.

Double-click the fax attachment to launch Interaction Fax 
Viewer. From there you can view, export, email, or direct 
the fax any way you like. Interaction Fax Viewer has its own 
Help system that includes instructions for all of these 
operations. 

To send a fax from any Windows application 
that allows printing:
1. Open the Windows application and create the fax.
2. From the File menu, click Print, and in the Printer 

Name list box, select Interaction Fax.
3. Click OK. Interaction Client .NET Edition converts the 

document to a fax and displays it in Interaction Fax 
Viewer.

4. From the Interaction Fax Viewer, from the File menu, 
click Send Fax.

5. In the Send Fax dialog box, fill in the appropriate fields 
and click OK, and after sending the fax click Exit.

Using Interaction Fax Viewer
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Interaction Mail lets you access and manage 
voicemails, faxes, and emails from any phone in the 
world. To start: 
1. Dial the main IC (corporate) phone number from

a remote telephone.
Or dial * from a station connected directly to IC.

2. Immediately dial (without waiting for prompts):
9 + your extension + your password + #
(e.g.,  9 6748 **** #).

Interaction Mail prompts you with input selections. You 
do not have to wait for prompts to enter commands.

Many Interaction Mail features described in this manual 
assume a text-to-speech (TTS) engine is properly 
installed and available to the xIC server.  If no TTS 
engine is installed, you may hear silence in certain 
areas in the system where a TTS engine would 
normally read information.  

Such areas include, but are not limited to, email and 
email folder access features, calendar access, envelope 
information and body text of a voicemail or fax, 
listening to Interaction Attendant schedule names 
when activating schedules, hearing custom status 
names that have not been recorded, and user names 
that have not been recorded. See your administrator if 
you have questions about whether or not you have a 
properly installed TTS engine.

Common shortcuts:

Listen to new voicemail: 1 + 1

Listen to saved voicemail: 1 + 2

After listening to new or 
saved voicemail, you can:

Forward to an extension: 2 + extension1 + 1

Reply to an outside caller: 5 + 4 + number + #

Check the arrival of new faxes: 2 + 1
Check the arrival of saved faxes: 2 + 2

Listen to new (or saved) email 3 + 1 (or 2)

Set status to "Out of the office": 5 + 1 + 12

Set phone to forwarded number*: 5 + 2 + 1 + number# + 1

  * for first time access

Record an "Out of office" greeting: 5 + 5 + 1

Activate "Out of office" greeting: 5 + 5 + 7

1To forward voicemail to multiple extensions, separate the 
extensions with # and end the list with ##.

Managing remote messages
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Personal Options (and Deleted Messages)

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2   

3

4

5

8

7

6

Main Menu

9 Access Outlook Options

Manage Fax Messages



Manage voice messages
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Fax Messages

Manage Email Messages

Send Voicemail

Manage Personal Options (and Deleted Messages)

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1 Manage Voice Messages

2

3

4

5

8

7

6

Main Menu

9 Access Outlook Options



Manage voice messages - press 1

Listen to New Messages 1

Listen to Saved Messages 2

Listen to Today’s Unread Messages 3

Save current 
voicemail 1

Forward message
to extension 2

Skip to next 
message 3

Replay current 
message 4

Reply to current
message 5

Play text in 
message body 6

Delete message, 
play next† 7

Play envelope 8

Send now 1
Record voice 
comment, attach 
to original 2

Call back to 
this number       1

Reply using 
voicemail           2

Listen to this 
number again     3

Call a different 
number             4

Enter destination 
number, then #.

Priority
High 1
Low 2
Normal 3

Delete current and all other
messages with this subject line* 1
Delete current and all other messages
from the same sender* 2

M
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      1

Enter the voicemail system and press 
1 to manage voice messages.
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Send message 1
Review message 2
Rerecord message 3
Set priority 4
Cancel and return *

Enter extension 
followed by #
Dial by name 2
Play list of 
workgroups 3

† To undo the last message (or group of messages) you deleted during this call, press 77 at
    any time while managing voice messages.

* These prompts are not played but the commands are functional.
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Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Personal Options (and Deleted Messages)

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2   Manage Fax Messages

3

4

5

8

7

6

Main Menu

9 Access Outlook Options



Delete current and all other
messages with this subject line * 1
Delete current and all other messages
from this sender * 2

Save current fax 1

Forward fax 
to extension 2

Skip to next fax 3

Receive current fax 4

Play envelope 6

Delete this fax† 7

Listen to text of 
fax message 8

Manage fax messages - press 2

Enter the voicemail system and press 2 to manage faxes.

M
a

n
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Enter destination 
number followed 
by #

Send now 1
Record voice 
comment, attach 
to original 2

Enter extension 
followed by #
Dial by name 2
Play list of 
workgroups 3

Priority
High 1
Low 2
Normal 3

Send message 1
Review message 2
Rerecord message 3
Set priority 4
Cancel and return *

Listen to New Faxes 1

Listen to Saved Faxes 2

Listen to Today’s Unread Faxes 3

† To undo the last message (or group of messages) you deleted during this call, press 77 at any time
    while managing fax messages.

* These prompts are not played but the commands are functional.



Manage email messages
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Fax Messages

Send Voicemail

Manage Personal Options (and Deleted Messages)

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2  

3   Manage Email Messages

4

5

8

7

6

Main Menu

9 Access Outlook Options



Save current email 
message 1

Forward message 
to extension 2

Skip to next 
message 3

Replay current 
message 4

Reply to local 
email with voice 5

Play text in 
message body 6

Delete this message, 
play next† 7

Play envelope 8

Record message and press 1

Send message 1
Review message 2
Rerecord message 3
Set priority 4
Cancel reply and return *

Send now 1
Record voice comment, 
attach to original 2

Enter extension 
followed by #
Dial by name 2
Play list of 
workgroups 3

Priority
High 1
Low 2
Normal 3

Delete current and all other
messages with this subject line* 1
Delete current and all other messages
from the same sender* 2

Manage email messages - press 3

Enter the voicemail system and press 3 to manage email.
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Listen to New Email 1
Listen to Saved Email 2
Listen to Today’s Unread Email 3

† To undo the last message (or group of messages) you deleted during this call, press 77 at any time
    while managing email messages.

* These prompts are not played but the commands are functional.



Send voicemail
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Manage Fax Messages

Manage Personal Options (and Deleted Messages)

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2  

3

4   Send Voicemail

5

8

7

6

Main Menu

9 Access Outlook Options



Record the message... 

Send message 1          
Review message 2
Rerecord message 3
Set priority 4
Cancel reply and return *

Enter an extension, or enter multiple extensions 
separated  by a # and end the list with ##
Optionally dial by name 2
Optionally play list of workgroups 3

Send voicemail - press 4

Enter the voicemail system and 
press 4 to send a voicemail.

S
en

d
 vo
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m
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Priority
High 1
Low 2
Normal 3



Manage personal options (and deleted messages) Options 1 through 3
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2

3

4

5   Manage Personal Options (and Deleted Messages)

8

7

6

Main Menu

9 Access Outlook Options



All calls 1
Internal calls 2
External calls 3
Unknown calls 4

Enter 1 to 10 digit 
password followed by  #.

Set date, 
time 
(military 
format), or 
both, 
depending 
on selected 
status

Set Interaction
Client Status 1

Set Forward
Number 2

Change IC
Password * 3

Manage personal options (and deleted messages) Options 1 through 3
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O
ptions 1 through 3

* You can not change to or from 
a blank password.

Enter remote 
phone number 1
Enter call 
coverage 
settings 2

Modify forward 
coverage options 1
Modify DND 
coverage options 2
Modify phone 
coverage options 3
Modify "no answer"
coverage options 4
Change coverage
phone number 5
Modify voicemail
destination 6

Enter internal number 
or IC extension 
followed by #

My voice mailbox 1

Call coverage #
mailbox 2

Current number is . . .
Keep current number 1
Change this number 2

Available 1 Away from Desk 9
Available, Forward 2 Available, No ACD 10
At a Training Session 3 On Vacation 11
At Lunch 4 Out of the Office 12
Do Not Disturb 5 Out of Town 13
Gone Home 7 Working at Home 14
In a Meeting 8 Available, Follow Me 15

Enter the voicemail system and press 5 to manage personal options.

* You may have status choices that do not appear in this list. If you have
   questions about available status options, contact your IC Administrator.
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2

3

4

5   Manage Personal Options (and Deleted Messages)

8

7

6

Main Menu

9 Access Outlook Options



Set verbose/brief 
playback mode 1
Sort by oldest/
newest messages 2
Play high priority 
messages first 3
Play mailbox 
extension greeting 4
Play current 
status greeting 5
Configure available 
messages 6
Configure available 
saved messages 7

Record Out of Office greeting    1
Hear Out of Office greeting    2
Record No Answer greeting    3
Hear No Answer greeting    4
Record your name    5
Hear your name prompt    6
Activate Out of Office greeting      7
Turn off Out of Office greeting 8
Turn off No Answer greeting    9

Verbose 1
Brief 2

Oldest first 1
Newest first 2

Activate 1
Deactivate 2

Voicemail 1
Fax 2
Email 3

Set Playback 4
Options

Manage 
Personal 
Prompts 5

Manage 
One Number 
Follow Me 6

Activate 1
Deactivate 2

Manage personal options (and deleted messages) Options 4 through 6
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O
ptions 4 through 6

Turn Follow Me on or off 1  Edit a telephone number 4
Listen to current configuration options    2  Delete a telephone number 5
Add a telephone number 3  Previous Menu *

Enter the voicemail system and press 5 to manage personal options.



Manage personal options (and deleted messages) Option 7
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2

3

4

5   Manage Personal Options (and Deleted Messages)

8

7

6

Main Menu

9 Access Outlook Options



Manage 
Deleted 1
Voicemail †

Manage 
Deleted
Faxes † 2

Save current 
voicemail 1
Forward to 
extension 2
Skip current 
message 3
Replay message 4
Reply to message 5
Play text in body 6
Delete message 
(final) 7
Play envelope 8 Enter number, then #Manage  

Deleted  
Messages ‡ 7
(continued 
on next 
page)

Send now 1
Record 
comment, 
attach to 
original 2

Send message 1
Review message 2
Rerecord 
message  3
Set priority 4
Cancel and 
return *

Call this number back 1
Reply using voicemail 2
Replay this number 3
Call a different number 4

Manage personal options (and deleted messages) Option 7

Enter the voicemail system and press 5 to manage personal options.
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O
ption 7

Enter extension 
followed by #
Dial by name 2
Play list of 
workgroups 3

Priority
High  1
Low  2
Normal  3

Delete current and all other
messages with this subject line * 1
Delete current and all other 
messages from this sender *       2

Save current fax 1

Forward fax 
to extension 2

Skip to next fax 3

Receive current fax 4

Play envelope 6

Delete this fax 7

Listen to text of 
fax message 8

Enter destination 
number followed 
by #

Send now 1
Record voice 
comment, attach 
to original 2

Enter extension 
followed by #
Dial by name 2
Play list of 
workgroups 3

  Priority
High 1
Low 2
Normal 3

Send message 1
Review message 2
Rerecord message 3
Set priority 4
Cancel and return *

‡ Notes/Domino users cannot manage deleted messages via the TUI.
† A supplementary menu may appear between these commands and the next menu.  Press 1 to listen to new 

(un-opened and deleted) voicemails or faxes. Press 2 to listen to saved (heard/read and deleted) voicemails or faxes.
* These prompts are not played, but the commands are functional.



Manage personal options (and deleted messages) Option 8
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† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1

2

3

4

5   Manage Personal Options (and Deleted Messages)

8

7

6

Main Menu

9 Access Outlook Options

During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.



Alert when I receive 
any voicemail messages 1
Alert when I receive a new fax 2

Turn off message notification 1
Turn on email-based alerts 2
Turn on pager-based alerts 3
Turn on telephone-based alerts 4
Turn on alerts based on a defined pager carrier 5

Alert me any time of day 1
Alert me during certain hours 2
Set Start/End times 3

Set time in military format. For 
example, 0900 for 9:00 a.m. or 
1630 for 4:30 p.m.

Manage personal options (and deleted messages) Option 7 (cont'd) and Option 8

For every voicemail 1
For urgent voicemails only 2
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O
ption 7 (cont'd) and O

ption 8

Enter the voicemail system and press 5
to manage personal options.

Voice messages 1
Fax messages 2
Email messages 3

Confirm 1
Cancel 2

Record message, 
hang up,   OR 
record message, 
press 1

Send message 1
Review message 2 
Rerecord message 3
Set priority 4
Cancel *  

Priority
High  1
Low  2
Normal  3

Enter extension 
followed by #
Dial by name 2
Play list of 
workgroups 3

Save current email   1
Forward to extension 2
Skip current message 3
Replay current message 4
Reply with voice 5
Play text in body 6
Delete this message 7
Play envelope 8

Manage 
Deleted
Email  † 3

Restore All
Messages 4
Erase All 
Messages 5

Manage 
Deleted
Messages 
(cont'd)      7

Personal 
Notification 
Options     8 ‡

Send now 1
Record comment 
attach to original 2

† A supplementary menu may appear between this command and the next menu.  Press 1 to listen to new 
(un-opened and deleted) e-mail messages. Press 2 to listen to saved (heard/read and deleted) e-mail messages.

Set alert types 1
Set alert reasons 2
Set alert schedules 3

‡  Users with directly assigned system administrator rights can remotely activate an unplanned schedule by selecting 
9 from the Personal Options menu. See the Interaction Attendant online help for further details. 



Access the private company directory
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Initiate an Office-Wide Alert

Manage Personal Options (and Deleted Messages)

Access Another Mailbox Folder

1

2

3

4

5

8

7

6   Access the Private Company Directory

Main Menu

9 Access Outlook Options



Access the private company directory - press 6

Dial this person's extension 1
Dial this person's home telephone 2
Dial this person's mobile number 3

Enter extension followed by     #
Optionally dial by name 2
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Enter the voicemail system and press 6 to 
access the company directory.
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Initiate an office-wide alert
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Access the Private Company Directory

Access Another Mailbox Folder

1

2

3

4

5

8

7   Initiate an Office-Wide Alert

6

Main Menu

9 Access Outlook Options

Manage Personal Options (and Deleted Messages)



Initiate an office-wide alert - press 7

You can use this option to initiate an office-wide search for an available extension. 

After you press 7, CIC or EIC will search all extensions with a status set to "Available" or 
"Available, No ACD", and will route your call to each extension consecutively until someone 
answers.

In
itiate an
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     7
Enter the voicemail system and press 7 
to initiate an office-wide alert.
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Access another mailbox folder
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Voice Messages

Manage Email Messages

Send Voicemail

Manage Fax Messages

Access the Private Company Directory

Initiate an Office-Wide Alert

1

2

3

4

5

8 Access Another Mailbox Folder

7

6

Main Menu

9 Access Outlook Options

Manage Personal Options (and Deleted Messages)



You can use this feature to dial into the system and gain access to other Inbox subfolders*. By default, 
your Inbox is always opened upon entering the system. When you press 8 from the main menu, the 
system queries all subfolders in your Inbox and creates a dynamic menu for these subfolders.  The 
system also creates menu options to access Sent Items and Deleted Items. 

Note
Your menu options may vary, depending on the number of subfolders created below your Inbox 
folder. Press 0 at any time to return to the Inbox. 

For example, assume you have three subfolders beneath your Inbox:  Administration, Personal, and 
Support. After you press 8 from the main menu, IC presents you with the following menu options:

Administration 1 Personal 3 Deleted Items 5
Support 2 Sent Items 4 Return to Inbox 0

Follow these prompts to access your custom subfolders, Sent Items folder, or Deleted Items folder.

Access another mailbox folder - press 8 A
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Enter the voicemail system and press 8 to 
access another mailbox folder.
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* Subfolders must contain messages to be listed.



Access Outlook options
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During message playback, you can:
Save current message 1 Fast forward 6 seconds 6
Forward message to extension 2 Delete current message 7
Skip to next message 3 Slow down voicemail playback 8†

Replay current message 4 Speed up voicemail playback 9†

Rewind 6 seconds 5

Commands always available:
Return to previous menu *
Finish a key entry #
To forward voicemail, faxes, or email to multiple extensions, separate the 
extension with # and end the list with ##.

† Some options require Interaction Media Server enabled for Advanced Operations. 
Contact your IC Administrator if you have questions.

Dial * 9 followed by:
Your extension ________
Your password ________
# (to complete password)
IC will not prompt for extension and password.

Enter the system

Manage Fax Messages

Manage Email Messages

Send Voicemail

Manage Personal Options (and Deleted Messages)

Initiate an Office-Wide Alert

Access the Private Company Directory

Access Another Mailbox Folder

1 

2

3

4

5

8

7

6

Main Menu

9   Access Outlook Options

Manage Voice Messages



Access Outlook options - press 9 A
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Access Calendar 1

Access Out-Of-Office 
Assistant Options 2

35

Hear a list of today’s meetings 1

Hear a list of meetings for another date 2 Enter the 2-digit month, 2-digit 
date, and 2-digit year

Turn Outlook out-of-office assistant on 1

Turn Outlook out-of-office assistant off 2



Notes
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